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Design tasks
The previous chapter covered the process of manipulating the
content of the book. Now let’s switch gears for a discussion of how
that content is going to look.

I’d like to pause a minute to point out that the process of going
from author to editor to typesetter to designer to printer does not
have to be a perfectly linear process. In fact, many times these
roles get all mixed up and tasks are done out of order. For example,
you might have a graphic artist design the book and provide you
with a template to use while writing. That way, you could live
with the design for a while and decide whether it suits you. Some
tasks have to be done prior to others, but what is particularly
interesting about wearing multiple hats is that you find out how
important it is for each of the participants to work together and
make each other’s job easier.

Choosing a size for your book
One of the most critical decisions, one that will impact virtually
everyone else’s job, is the size of your book. You need to decide on
a size before you can make design decisions regarding type size and
column width. It also must be done before you begin scanning any
photographs or sizing tables. Your size decision will determine the
amount of space the book takes up on the shelf and the envelope
you’ll need to fit it in for mailing. It will also have implications for
the book’s binding method and the cover.
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For the sake of simplicity, I strongly recommend that you choose a
size based on a standard 8½” x 11” sheet. Use of this standard size
will simplify production and keep the overall cost of the job down.
The 8½” x 11” size is also well suited to digital printing devices
that will print cost-effective short print runs (as opposed to offset
printing presses that are the traditional method for printing many
copies of books). If you have your heart set on an unusual size, go
ahead and see what kind of price your print shop offers you. Print
shops can do many things for you, but they are most effective (and
they will give you the best price) when you ask them to do things
that are easy for them.

It is possible to create books or booklets using common paper sizes
other than 8½” x 11”. (For example, 11” x 17” and 8½” x 14”
sheets are commonly available in digital print and copy shops.) It
is also possible to create books and booklets made from folded 8½”
x 11” sheets (or even folded 11” x 17” or 8½” x 14” sheets). You
can take advantage of these sheets to produce books and booklets
in a variety of sizes. You can even use Microsoft Word to create a
page of just about any size. It’s just that when you move away from
an 8½” x 11” page, things get a lot more complex.

For example, half of an 8½” x 14” sheet is 8½” x 7”, which is very
close to a typical 9”-high by 7”-wide paperback. You could create
an 8½” x 7” layout in Word, but your print shop would have to
have the expertise (and software) to print your 8½” x 7” layout
twice side-by-side on an 8½” x 14” sheet. This so-called 2-up
layout would then be printed in proper page order and trimmed
down the middle into two 7” x 8½” unbound book blocks. With
the right software this isn’t hard to do, but you can’t assume that
any print shop will be able to do it. And it’s not as simple as
printing out an 8½” x 11” book and binding it.

If you do choose to use a size other than 8½” x 11”, be sure to
consult with your print shop very early in the process. You need to
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be sure that these decisions about the format of your book do not
create production problems for the print shop.

Fonts and typefaces
A font is a computer file that determines how letters are rendered
on your computer screen or printer. The terms “font” and
“typeface” have a similar, but not identical meaning. A font is the
source of a printed (or viewed) letter shape. A typeface, on the
other hand, is the printed (or viewed) result of a font. For
example, if you had a rubber stamp with the letter “A” on it the
rubber stamp would be the font, and the printed result would be
the typeface. With a computer, the font is the actual source
computer file with the information on the shape of each letter.

If you use Microsoft’s Windows operating system on your
computer, chances are that you are using “TrueType” fonts. Later
on in the “Production tasks” chapter you will read about another
kind of font called a PostScript font. You can use either type, but
for reasons that will become clearer later, I recommend that you
find and install some PostScript fonts on your machine. If you
attend printing trade shows, you may be able to get a free CD from
Adobe Systems (one provider of PostScript fonts) that includes
some PostScript fonts. You can also purchase from Adobe a
collection called Type Basics, which includes sixty-five PostScript
fonts for $65. Look for additional information on Adobe’s web
site: http://www.adobe.com

An Adobe font utility called Adobe Type Manager (ATM) is
another useful tool that helps you install the fonts on your
computer.

You really don’t need very many fonts to do a book. In general, a
sans-serif font for the headings and a good readable serif font for
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the text will do.25 I have used Adobe’s Garamond previously
because it is easy to read and I like the way it looks. This book’s
text is set in Goudy. The headings are Adobe’s Myriad Roman.
Both typefaces come with the full suite of fonts, including roman,
italic, bold, and bold italic. (This avoids any computer-generated
imitations of the italic or bold variations.)

Figure 8 – A serif typeface (left) next to a sans-serif typeface (right)

Intelligent selection of fonts can make your words look good in
print. Poorly chosen fonts can make your book unreadable. We’ll
discuss fonts in greater detail in the “Production tasks” chapter.

Working with Word templates
Once you have determined a size for your book, then you need to
find, adjust, or create a Microsoft Word template that is
appropriate for your document. A Word template contains the
instructions for the fonts, spacing, and other parameters used to
format the document.

I’m going to assume that you have installed the required fonts.
However, you should go through the exercise in this chapter even
if you haven’t. You can always go back and change your fonts
later.

Books generally have a few key design elements. Microsoft Word
provides you with the ability to create a template that includes

                                     
25 If you have never heard of serif and sans-serif fonts, then compare the type in the headings and text of
this book. The chapter headings are sans-serif. The text is serif. The strokes of the serif text are more
elaborate and finish with fine lines and small embellishments. The strokes of the sans-serif chapter
headings are not adorned with any extra embellishments.
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styles that will make it easy for you to format your book. In this
section, I’ll show you how to create a set of styles for your book.
These styles will cover:

•  Headings and subheads

•  Body text

•  Headers and footers

•  Tables of contents and indexes

•  Title page elements

•  Other elements like notes or tables

To start, open a new document in Word. Whenever you open a
new document in Word, Word will ask you which template you
want to use. Choose “Blank Document” under the “General” tab.
This will open a new document based on the “General” template.

Setting the page size and margins
To set the page size and margins, go to the “Page Setup” selection
under the “File” menu. This will display four tabs:

•  Margins – This tab allows you to set the margins between the
edge of the page and the text block. It also allows you to
position the header and footer. The default margins (1” on the
top and bottom and 1.25” on both sides) give your page plenty
of breathing space. If you click the “Mirror margins” box, Word
will show you two facing pages and allow you to make
adjustments on them. I recommend that you stick to the simple
one-page view. The default positioning for the headers and
footers (½” from the top and bottom) is also good. Any of these
figures can be adjusted if you wish to gain more space for text or
increase the margins.

•  Paper Size – The default paper size is a portrait letter page (i.e.,
8½” x 11”). Leave this as is unless you want to use another
paper size.
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•  Paper Source – This tab refers to the printer’s paper tray and
does not need to be altered.

•  Layout – Among other things, this tab allows you to set
whether your headers and footers are different for right- and
left-hand pages. Most books have different right- and left-hand
headers/footers, so check this box. You can also set a different
header/footer for the first page of a section, and you may wish to
do this if you don’t want a header/footer to appear on the title
page. Unfortunately, Word has a number of quirky features and
setting a different header/footer for the first page of a section is
one of them. I have found that the header/footer of the first
page is sometimes corrupted for some unknown reason when
the table of contents or index is updated. You should pay close
attention to these headers, particularly if you try to include
graphics within the header. If you want a more secure
workaround for eliminating the header/footer from certain
pages, you can cover a header/footer with an opaque white text
or graphic box. (This is the electronic version of “white-out”.)
Just be sure that you do this late in the process because if you
add extra pages, you will find that your blank header/footer will
remain on its original page even though the page you really
wanted it to be on has moved elsewhere in the document.

Creating a header and footer
You laid the groundwork for your headers and footers when you set
different right- and left-hand pages under “Page Setup”, now you
need to create them. Go to “Header and Footer” under the “View”
menu. This brings up a floating menu and allows you to add text
to the header and footer text blocks. The menu has some useful
tools that you will need to understand. Three buttons at the far
right of the menu allow you to maneuver between the header and
footer as well as between the right- and left-hand pages. The
button that looks like an open book brings up the Page Layout tab
from Page Setup in case you need to make any adjustments there.
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There are also several buttons that allow you to insert information
like the date, time, page number, and number of pages. You may
wish to include the date and time in a header for the purpose of
identifying when a given draft was done, but you’ll want to remove
this from the final version. The “number of pages” button is useful
if you want to note that this is “page 3 of 100” but unfortunately
this is another one of the quirky features of Word, and I would
avoid doing this if I were you. Too often this number is not correct
when you reopen a document. (For example, the header or footer
may appear as “page 3 of 2”.)

Figure 9 – Header and footer floating menu

For this book, I created fairly simplistic headers and footers. (Have
a look!) For the headers, I have simply centered the book title
over a thin rule. To do this, insert your cursor within the header,
hit a tab (which brings it to a pre-set centered tab), and type the
book title. For the footers, I have inserted a page number at the
outside edge26 of the page and a brief copyright line with the year
and my name. For the left-hand page, type the word “Page” and
then space. Next press the “Insert Page Number” button. (It’s the
one with the number sign inside.) Then hit two tabs and type
whatever name and copyright information you desire.27 For the
right-hand page, type the name and copyright information first,

                                     
26 Open any book so that you can view two pages side-by-side. Of course, the left-hand page, also called a
verso, is on the left, and the right-hand page, also called a recto, is on the right. Readers generally look for
the page numbers toward the outside edge of the page (i.e., away from the gutter at the center of the open
book). The page number can either be in the header or the footer. Sometimes the page numbers are
centered in the header or footer, but more frequently they are to the outside, so you have to place them
differently for a right-hand and left-hand page. (If a designer really wants to confuse the reader, he/she puts
the page number somewhere outside of these generally accepted areas.)
27 If you are using the “Auto Correct” feature and type an open paren, a lower case “c”, and a close paren, it
will convert those characters automatically to a copyright symbol.
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then tab twice, and then put in the “Page” and insert the
automatic page number. I will describe how to set the style for
headers and footers below. This will also include a discussion of
how to make a rule above or below.

About styles in Word
The Microsoft Word template that you opened (“General”)
already has some existing styles. You need to adjust these to reflect
the styles that are appropriate for a book. Once you do this,
everything to which you apply that style will be formatted in the
appropriate way.

Be sure that you are in “Page Layout” mode (under “View”), then
insert your cursor near some text. To the upper left side of your
screen, you should see three white rectangles (see below). The first
contains the name of the style, the second contains the name of
the font, and the third contains the size of the font.28 All three
boxes have pull-down arrows that allow you to change the
settings. Choose the pull-down arrow by the “Style” box at the far
left. You should see a pull-down menu of style selections including
Heading 1, Heading 2, and Normal, etc. Choose “Normal”.

Figure 10 – Style, Font, and Font Size boxes

We will now change the Normal style so that it is suitable as the
body text of your book. Under “Format” select “Style”. This brings
up a menu that shows you a brief description of the style along
with a visual preview. You may also select a new style at this point
from a list at the left.

                                     
28 If you select a large amount of text, you may notice that one or more of these boxes is blank. For
example, the font size will be blank if the text you have selected contains two or more sizes.
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Figure 11 – The Style menu

For the moment, let’s stick with the Normal style. Choose the
“Modify” button. This brings up another menu with a variety of
choices. The most important selection is called “Format”, which
allows you to change settings like Font, Paragraph, Tabs, Border,
Language, Frame, and Numbering. You will spend most of your
time in the Font and Paragraph areas. However there are a few
points worth mentioning here before we move on:

•  Style for the following paragraph – A selection in the upper
right hand corner allows you to select the style for the following
paragraph. In other words, if I am typing a paragraph with the
Normal style and then hit “Enter”, it will apply the specified
style to the following paragraph. In this case, the following
paragraph should be Normal, because you generally do want to
type multiple text paragraphs in a row, and Normal is the Style
we’re using for text. With headers, you generally want the
following paragraph style to be Normal too, because text
follows all headers. This makes it easier for you while you are
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writing because the most appropriate styles are applied
automatically.

•  Add to template – A check box allows you to add the
corrections to your template. You do not need to check this for
now. Later, we will save the completed template for future use.
If you make subsequent changes to styles later on, you may wish
to add them to your template.29

•  Automatically update – If checked, this feature will
automatically make corrections to styles as you update them in
your document. You should also leave this unchecked because
it has the potential to cause a ripple of drastic changes
automatically through your document. For example, if you
change the size of some Normal text and the “Automatically
update” box is checked, Word will change all the Normal
paragraphs to that size.

•  Shortcut key – You can create shortcuts for your styles so that
you can apply style changes with a keystroke (rather than a
click of the mouse). Honestly, setting styles with the mouse is
not that hard, so I don’t think that much is gained by this. If
you choose to use this, you need to reassign certain keys on your
keyboard to be a shortcut key. The most appropriate choices are
from the numeric keypad.

The next selection on the Modify Style menu is “Format”. If you
press the format button, you get the following choices: Font,
Paragraph, Tabs, Border, Language, Frame, and Numbering. We’ll
discuss each individually:

•  Font – The “Font” selection brings up a menu with three tabs:
Font, Character Spacing, and Animation. The Font tab gives
you the ability to change the font, its style (italic, bold, bold
italic), and its size. You can also change color, add an

                                     
29 This is really only important if you intend to do multiple books with the same style.
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underline, or apply some special effects. (Don’t be tempted to
use the underline or the special effects. If you want to add
emphasis, you should do so through the judicious use of fonts
rather than through these high-tech tricks.) There is also a
preview screen that shows you the impact of your selections. It
will also report additional information about the font, for
example, whether it’s a TrueType, scaleable printer font (i.e., a
PostScript font), or even whether it’s installed on your machine
at all. (If you use a template with a style that includes a font
that is not installed on your system, Word will substitute “the
closest available” font.) One last word of warning: Be careful
how you use the “Font Style” setting. In general, it should be
set to “Regular” and not to “Bold”, “Italic”, or “Bold Italic”. You
should then choose the appropriate font in the “Font” setting. If
you want to choose a bold font, then find a bold font, rather
than setting the style as “Bold”. For example, I have often used
an Adobe family of fonts called Garamond. This included both
a regular and bold version. When I needed bold, I simply chose
the bold version. In some cases, you will find writers who assign
the “Bold” setting to an already bold font. This makes the font
look bloated and unattractive.

•  Paragraph – The “Paragraph” selection gives you control over
characteristics like indentation, spacing, and selected line or
page breaks. The menu includes two tabs: “Indents and
Spacing”, and “Line and Page Breaks”. Under “Indents and
Spacing”, you can define the characteristics that determine how
the paragraph aligns (left, center, right, and justified) as well as
the spacing above and below it. You can set an indent for the
entire paragraph, or just for the first line. You can set the line
spacing if you want, but generally you should leave it set at
single spacing. You can set the outline level, which is important
because it allows you to include the style in a table of contents
if you desire. There is also a link to the Tabs menu, should you
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wish to associate any tab settings with your styles. In addition, a
preview screen shows you the impact of your decisions. Under
“Line and Page Breaks”, your choices include “Widow/orphan
control”, “Keep lines together”, “Keep with next”, “Page break
before”, “Suppress line numbers”, and “Don’t hyphenate”. You
will see how these choices come in handy as we assign the styles
for a typical book. For example, you will use “Keep with next”
to assure that a heading is not separated from the text that
follows it.

•  Tabs – This is a small menu that allows you to set tabs for a
given style. In general, you will set indents rather than tabs for
most book styles, but you may find this feature useful if you use
colons within a heading style and you want the position of the
following text to fall in a consistent location. For example, with
“Chapter 4: Accounting”, an appropriately set tab following the
colon would assure that the word “Accounting” falls in a
consistent location relative to other chapter headings.

•  Border – “Border” is a powerful menu that allows you to format
the rules, boxes, and fills surrounding a block of text. I
recommend that you use only a small piece of its capability,
that is, the ability to draw rules above and/or below a heading
or text block. To do this, choose the Borders tab and select the
Box setting, the solid line style, the color black, and the half
point width. At that point you should see a full black box
surrounding the text in the preview. Then, by either clicking
directly on the side of the box that you want to remove, or by
using the buttons to the side, you can set the line to fall above
or below the text. The “Options” button allows you to set the
distance from the line to the text. This feature comes in handy
for page headers and footers, as well as headings within your
book. These lines will continue the full length of the text



From Microsoft Word to Print

Copyright © 2001, Jim Hamilton www.greenharbor.com Page 51

block.30 The Border menu also gives you the ability to create
sophisticated headings that drop white type out of a black
background, but you should leave that kind of design work to
the professionals unless you have some experience with graphic
design.

•  Language – This feature allows you to set the language used for
spell and grammar checking. This is not generally something
that you would change from one style to another in your
document, but there are some useful aspects. For example, if
you are using Word’s U.S. English dictionary, the spelling and
grammar checker will have a hard time with text in foreign
languages. You may choose to assign these sections a style that
uses the appropriate dictionary. Or, you may choose to mark
these “(no proofing)” so that they are ignored by the spell and
grammar checker. This can be useful for direct quotes, which
may intentionally include misspellings or improper usage. In
addition, there is something particularly absurd about applying
Word’s spelling and grammar check to the work of famous
authors who you may have quoted in your book. However, be
very careful with the “no proofing” feature, because you don’t
want to accidentally turn off the proofing for other sections of
your document. You may then assume (incorrectly) that they
have been checked and passed by the spelling and grammar
checker.

•  Frame – “Frame” allows you to adjust the way that text flows
around a graphic box. In general, I think that it is best not to
have text flow around a graphic on all sides.

•  Numbering – This selection brings up a “Bullets and
Numbering” menu with three tabs that allow you to set the
style for bulleted or numbered items. If you have very

                                     
30 There may be a way to make them continue only for the length of the word, but if there is, I haven’t
been able to find it.
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sophisticated bulleting or outlining requirements, you may find
this useful. In general, I have created a single bullet style and
have used that whenever necessary.

Setting styles
The menus described above are ones that you will visit frequently.
To show you how to use them, let’s create some styles that are
appropriate for a typical non-fiction book. If you are writing
fiction, you will probably need even fewer styles.

For any of these style changes, start a new line by hitting “Enter”
(i.e., a carriage return) and set the style to the style setting that
you want to adjust. (Remember that you set the style by selecting
the Style box toward the upper left hand corner of your screen.) In
the following sections, I will describe how to adjust existing Word
styles so that they are suitable for a book.

Headers and Footers
Let’s start with the style for the headers and footers. To get to the
headers and footers, choose “Headers and Footers” under the
“View” menu. This should bring you to your first header. You will
see that the Style window to the far left contains the style
“Header”. Now choose “Style” under the “Format” menu. This will
bring up the style parameters for “Header”. Press the “Modify”
button to bring up the “Modify Style” Window. Then press the
“Format” button and change the parameters that you wish. For
example, you may wish to change the font size or add a rule under
the header. Once your changes are complete, press “Okay”. You
will need to press “Okay” again to leave the “Modify Styles” menu.
Then press “Apply” to apply your changes. If you don’t like what
you see you can always undo the changes.

Once you have accepted the changes to the Header style, you can
move on to the Footer and apply changes in the same fashion. In
general, the header should be somewhat smaller than the body
text so that it does not attract undo attention away from the most
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essential part of the book. I used the same font as the chapter
heading, but made it smaller (ten points instead of fourteen
points). I added a half point rule under the header and above the
footer. I used the pre-set tabs to center the title in the header and
to set the page number and copyright line in the appropriate
places in the footer.

 Figure 12 – Modify Style menu

The body text
The text of a book should be easy to read. Therefore you should
make it large enough and also select a font that is intended as a
text font.31 Times New Roman is an example of a TrueType font
that is a very legible serif font that is often used for text. Designers
tend to avoid Times New Roman because it is overused, but it is a
safe choice for body text. In any case, you should select a serif font

                                     
31 Some fonts are created specifically for headlines and are not easy to read when they are reproduced in
small sizes or with many words. Other fonts are intended for special purposes, like script fonts, and are not
suitable for long blocks of text.
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for your body text and set it no smaller than 12 or 14 points for
good legibility.

Start with the Word style called “Normal” and adapt it as you
wish. I chose a PostScript font called Goudy and set the size at 16
points. The paragraph is single spaced and set flush left. I added no
space before and 6 points after. I set the outline level to “Body
text”. I turned on Widow/orphan control, which assures that a
single line (either the first or the last) from a paragraph is never
stranded at the beginning or the end of a page.32

I recommend that you either set your body text to flush left (like
this book) or justified (where the text is stretched out so that the
column edge is straight at both the right and the left). Except for
poetry, which might be centered or perhaps flush right, I can’t
think of any book that is not well served by the flush left or
justified settings. However, justified text may not look good if you
set your column too narrow or if there are only a few words in each
sentence. With few words in a narrow column, the spaces between
the words are often expanded to justify the text. For good
readability, set your column width and font size so that a line does
not contain more than fifteen or sixteen words.33

Chapter title, headings, and subheadings
For the chapter title, I chose the style called “Heading 1” and
adapted it so that each chapter would start on a new page with a
large amount of space above the chapter title. To do this, modify
“Heading 1” using the appropriate Format tools to increase the

                                     
32 It looks odd if a single line that is part of a paragraph stands by itself. To prevent this, Word pushes the
line to the next page or brings a second line to accompany it so that there are never fewer than two lines
standing alone.
33 In the same way that you should limit the number of words in a line, you can also improve readability by
limiting the length of paragraphs. There is no automated way to handle this, but as you write you should
try to keep paragraphs from becoming excessively long. In general, paragraphs that exceed a dozen or so
lines are visually boring. Breaking up long paragraphs into smaller pieces will make your book easier to
read.
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“Space before” to 100 points. (Here is how you get there: Format
to Style to Modify to Format to Paragraph.) This is also where you
can check the “Page break before” box. This feature is under the
“Line and Page Breaks” tab.

Figure 13 – Paragraph menu

I chose a sans-serif PostScript font called Myriad Roman. I set it to
“Bold” under Font Style. (I was able to do this because I have the
whole font family and I knew that Word would select the proper
font rather than artificially creating a computer-generated bold
version.) I set it to 24 points and assigned it as a “Level 1” heading
so that it would be at the top level when I created the table of
contents.

By this point, you can begin to see the relationship between the
body text you selected and the chapter heading. You should
choose sizes that complement each other, and yet provide
significant contrast for the other elements in your book. Book
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designers typically choose a serif font for the text and a bolder
sans-serif font for the top-level headings. Look at some of your
favorite books to see how the various elements were handled.

Adjusting the headings and subheadings should be a pretty easy
task for you now that you are familiar with Word’s style features. I
will describe how you might choose to format your major chapter
headings as well as two levels of sub-headings.

The trick when you have numerous heads and subheads is to build
a visual hierarchy that shows the relative importance of the
headings. This hierarchy must be constructed between the boldest
top level header and the body text. No header can appear less
important than the body text. When you chose your chapter title
and body text, in effect you were setting the two ends of the
spectrum. For this book that meant that I had to make my
headings and subheadings smaller or less bold than 24-point
Myriad Roman Bold, but stronger than 16-point Goudy.

Table 1 – The styles used in this book

Function Style name Font Size Style Indent Position Other

Chapter
title

Heading 1 Myriad
Roman

36 pt. Bold None Centered 120 points
before, 20
pt. after

Heading Heading 2 Myriad
Roman

18 pt. Bold None Flush left 12 points
before, 3
pt. after,
keep with
next

Subhead 1 Heading 3 Myriad
Roman

18 pt. Italic 0.2”
(left)

Flush left 6 points
before
(otherwise
based on
Heading 2)

Subhead 2 Heading 4 Goudy 18 pt. Roman 0.4”
(left)

Flush left (otherwise
based on
Heading 3)

Text Normal Goudy 16 pt. Roman None Flush left 6 pt. after
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The table on the previous page shows how I balanced size, style
(bold, italic, and roman), spacing, and indents to build this
hierarchy. I changed only two or three key elements from one
heading to the next. By the last heading I am not even using a
sans-serif font anymore. I have chosen a slightly larger version of
the body text font.

You can see from the table below how I balanced size, style (bold,
italic, and roman), spacing, and indents to build this hierarchy. I
changed only two or three key elements from one heading to the
next. By the last heading I am not even using a sans-serif font
anymore. I have chosen a slightly larger version of the body text
font.

The more heading levels you require, the harder the task becomes
for the designer. It’s also confusing for the reader, so you should try
to limit the number of headings as much as possible.

Once you have had a chance to see how your selections work in
practice, you may decide to change fonts, add or subtract space, or
fine tune your styles in some other fashion. This is exactly the
process that a book designer would use. No one, not even an
experienced designer, is able to make design decisions without
reviewing the impact of those decisions on appearance, legibility,
and readability.

Footnotes, captions, tables, and other elements
Microsoft Word has some tremendous automated features for
creating footnotes and captions, as well as for creating tables.

•  Footnotes – Creating a footnote is simple. Just place your cursor
where you want the reference number or symbol to appear and
then select “Footnote” from the “Insert” menu. Word then
opens a window where you can type in the footnote. If you
choose to have numbers, Word will automatically sequentially
number the footnotes and place them at the bottom of the
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relevant page. You can double-click on the footnote number if
you ever want to edit the footnote text.

•  Captions – The “Caption” command also appears under the
“Insert” menu. You can use this to sequentially number
captions automatically.

•  Tables – Making tables in Word takes a little bit of practice,
but it is a very useful feature. This is particularly true if you
want to insert information from a spreadsheet program like
Microsoft Excel. You will want to use this feature for text that is
tabular in nature and contains multiple columns. (See Table 1
in this chapter as an example.) If you find yourself typing
multiple tabs to get text to align, or, if you are spending too
much time trying to adjust tabs on the ruler bar, then you
should take the time to learn more about Word’s Table feature.

In the case of captions, footnotes, indices, and table of contents
entries, there are styles associated with each of these. You may
choose to have these based on your “Normal” text style, or you
may want to differentiate them through the use of a different font.
All of this is made possible by the use of styles in Word. Keep in
mind that your table of contents and index may have multiple
levels, and therefore multiple styles. These are often distinguished
through the use of indentation.

There are a few types of pages that appear in many books,
including the title page, copyright page, dedication page, and
colophon. You may wish to handle the headings and spacing for
these sections somewhat differently from other portions of your
book. Since these pages appear only once in a book, you may not
feel the need to create a separate style for them. However, it is
generally best to do so, because you can then rest assured that you
will not change them inadvertently if you adjust the style on
which they are based.
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Word’s Professional Report template
If you would prefer to work from an existing Word template, there
is one called “PROFREPO” (i.e., professional report) under
“Reports” that will work well as a book format. This template was
not installed on my computer, so I had to go back to my program
CD and find it and copy it onto my computer in the “Templates”
folder in the “Msoffice” folder. If you make a new folder in the
“Templates” folder, that name will appear as a tab selection the
next time you open a new Word file and select a template. When
you open a document with the PROFREPO template, it includes
some basic notes on how to use the template.

Figure 14 – The new document Template menu

If you create a document that you would like to use as a template
for future documents, then save the document as a “Document
Template” in the “Msoffice” folder. (Word identifies template files
with the .dot file extension.) Word will then present this as an
option the next time you open a new file. I created a “Books”
folder for the templates I have created. The files that I use as
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templates include examples of the key headings and text styles
along with a brief explanation of the use of the template.

Size-dependent elements
Word’s templates and styles are very flexible, and allow you to
make global adjustments to your book very easily. If you decide
later to use a different size for your book, and have used Word’s
templates and styles, it will be much easier to adjust your design to
the new format. However there are a few common book elements
that are dependent on size:

•  Tables – The “Table” feature in Word allows you to create
handsome tables, but the table needs to fit the page. If you
change the book’s size, the width of the text block, or the size of
the type, you will have to re-work your tables.

•  Scanned images or clip art – The printed quality of scanned
images and clip art depends on the size at which they are
reproduced. If you move your book to a larger size and wish to
enlarge your images, these elements will have to be adjusted
accordingly. If you move to a smaller size, you will probably
want to make the resolution appropriate for the chosen size.34

If you change the size of your book, you will have some significant
work to do in the areas described above, so it’s important to make
a size decision and stick with it. However, if your book is text only,
without tables, scans, or illustrations, then it is much easier to
adjust to changes in size.

Manual page and line breaks
Manual page and line breaks are a handy tool for formatting pages
and paragraphs in the way that you desire. When you insert a
manual page break, it sends the subsequent text to the next page.

                                     
34 The issue of scan resolution is discussed in detail in the “Art Tasks” chapter.
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When you insert a manual line break, it creates a new line (but
without starting a new paragraph).

To insert a manual page break, choose “Insert” from the main
menu and then “Break”. A menu appears giving you a choice of
“Page break” or “Column break”. Unless you have a multiple
column document, you should choose “Page break”. You also are
given the option of inserting some breaks, including “Next page”,
“Continuous”, “Even page”, and “Odd page”. I have usually
avoided section breaks, because when you create a new section,
Word will sometimes restart the page numbering at 1. And though
it is possible to adjust the page numbers for each section so that
the numbering is continuous, I think it is best to avoid adding
unneeded extra sections.

To insert a manual line break, press “Shift+Enter”. You might
choose to use a manual line break because it moves the text to the
next line without adding any space before or after the paragraph.
(Starting a new paragraph by hitting “Enter” could add extra
space, depending on the parameters of the style.) When you
“Show” all non-printing characters, a manual page break appears
at the end of a line as a small arrow.

Figure 15 – Paragraph mark ( ) and manual line break ( )

In general, it is best to avoid inserting manual line and page breaks
into a document until very late in the formatting process because
changes elsewhere in the document may render them totally
useless. However, once you have completed the bulk of your
writing and editing, you may find the need to add page or line
breaks to make document work out the way that you want. For
example, I have inserted manual (so-called “hard”) page breaks for
a couple of reasons:

•  To get chapters to start on a right-hand page – As described
earlier, it is possible to set a Word style so that it makes each
chapter start on a new page. However, I haven’t been able to
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figure out an automatic way to create a style so that all chapters
start on a right-hand page. Therefore I manually added page
breaks late in the process so that all the chapters started on
right-hand pages. This ends up inserting blank pages, but I
preferred that to having chapters start on left-hand pages. An
easy way to check if the chapters are starting on right-hand
pages is to look at the table of contents. If the chapter page
numbers are all odd, then the chapters are all starting on right-
hand pages.35

•  To break material at a logical place – In some cases it just made
sense to move a paragraph to the following page.

•  To fit an illustration in an appropriate place – Large
illustrations can be difficult to place if you want them to be
close to the text describing them. You may have to insert hard
page breaks to accomplish this.

You may need a manual line break when you want to move a
single line to the next page or push a word down to the next line.
For example, in “The Writing 69th”, the words “B-17” and “B-24”
appeared frequently. In many cases, the “B-“ would be left alone at
the end of one line with the 17 or 24 beginning the next line.
This looked odd so I used a manual line break to move the “B-“
down to the next line.36

I am generally against putting such hard breaks into a document,
but I couldn’t figure out a way to automate the process in certain
cases. Placing hard breaks in a document can cause significant
problems if you change formatting (like font size or column
width). When that happens, you’ll find manual line breaks
breaking sentences halfway across the column, or manual page

                                     
35 This assumes that your book is duplex. If you are printing only on one side of the paper (i.e., simplex),
then all of the pages with text will be right-hand pages.
36 There is a way to do this automatically in Word using so-called “non-breaking hyphens”, but I could not
get them to work consistently.
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breaks creating nearly blank pages. If this should happen, you can
use Word’s Find/Replace feature to search for manual breaks.
Word’s Show/Hide feature will also help you identify these
“invisible” non-printing characters like spaces and paragraph
marks, but also manual line and page breaks.37

If you find yourself inserting a lot of paragraph marks to move text
to the next page, you should use a manual page break instead.

Ways to avoid manual formatting
Any time you see yourself doing a lot manual formatting, stop for a
minute and think whether a Style change or the Find/Replace
feature could make your task easier. Overall, be sure to avoid the
following errors:

•  Forgetting to use outline heading levels – Maybe you don’t like
the outlining feature in Word and therefore choose not to use it
while you are writing. That’s a bad move. Keep in mind that
the outlines are not only useful in writing, but they are also
extremely useful to the designer. When you use outlining you
are building a sensible framework that will be particularly useful
for formatting the book and creating the table of contents. In
addition, learning how to use Word’s Outline mode will come
in handy when you want to understand how documents are
formatted for display on the Internet. Web pages use a very
similar type of hierarchical structure for displaying information.

•  Manually assigning bold, italic or underlining – Don’t assign
bold, italic, or underlining using the menu buttons. If you
manually assign bold, italic or underlining, you aren’t taking
advantage of the Style feature of Word. It is much better to
update the appropriate Word style when you want to change a

                                     
37 You can Show or Hide these invisible characters by pressing the Show/Hide button on the menu bar.
You can also access this feature under the “Tools” menu by selecting “Options” and the “View” tab. Under
“Non-printing characters, select “All”.
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font. This gives you much greater flexibility to change it
automatically later. Now, you might not care about this if you
were the author, but since you are taking the roles of author
and designer, you should know that the designer will find
his/her work much easier if you do this.38

•  Correcting spacing by adding spaces instead of setting tabs –
When you make a table and use spaces instead of tabs to make
the words line up, you are setting yourself up for problems later
on. The width of a space changes depending on the font you
use and its size. If you change the font (or the size) you will
have to adjust everything manually to get it to line up again. If
you set tabs, the spacing will be consistent even if the font
changes. You can even set tabs as part of a style that can be
updated as needed. So definitely use Word’s Table feature, or,
make appropriate use of tabs instead of spaces.

Word’s Format Painter tool
Microsoft Word has a convenient tool for applying formats (and
styles) to text blocks. The Format Painter tool appears as a
paintbrush icon on the menu bar. To use Format Painter, select
the text that has the formatting you want to copy and select the
Format Painter icon with your mouse. Then select the text where
you want to apply the formatting. You can apply the selected
formatting to several locations, by double-clicking Format Painter.
Click the button again when you’re finished.

                                     
38Here an exception to that rule: You might like to create a bullet in which the initial word or words are
bold, but the rest of the text is roman. There may be a way within Word of creating a style that
automatically recognizes that the words preceding the dash should be bold and those following it are
roman, but I haven’t been able to figure out how to do it. If you want to do this, you must do it manually.
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Figure 16 – The Format Painter tool is the small paintbrush in the middle of
the bottom row

When Word goes bad
Microsoft Word is a great tool, but even so, there are going to be
times when it does unexpected things. For example, setting styles,
creating an index, using Search/Replace, and executing many
other normal tasks can all change your document in unintended
and potentially destructive ways.

In most cases, Word is just doing what you told it to do. For
example, you may make a small change, such as manually
adjusting the font size in a heading, and then find that the change
has been automatically applied to all of your headings. If this
happens to you, you probably checked “Automatically update” in
the “Modify styles” menu. This can be a handy tool, but in most
cases you don’t want to have this feature turned on.

In other cases, weird things happen that appear to have no
explanation. Chances are that some obscure Word feature is
causing the problem, but sometimes it will turn out that you have
discovered a software bug in Word. For example, I created a
document with different left- and right-hand page headers that
also had a first page header with an inserted graphic. Whenever I
update the index, the first page header disappears! I have to reset
the “Layout” tab under “Page Setup” and check the “Different first
page” box for “Headers and Footers”. When I do so, the first page
header reappears. I couldn’t figure out why this happens, so I just
have to remember to check the first page header every time I
update the index. When things like this occur, you’ll just have to
figure them out the best you can.
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Styles are another potential source of difficulty, particularly when
you are copying and pasting text from other documents. Text that
you copy from another document will carry with it the style name
from the previous document. If that style name matches a style
name in your document, then the style from your document will
usually be applied to it. I say “usually” because sometimes it is and
sometimes it isn’t. Frequently, the font will be assigned correctly
but the size will not. This means that you need to check the styles
of copied text very carefully to be sure that the font, size, and
other parameters have been assigned correctly to copied text. In
some cases, you will copy text that uses a style that is not one of
the ones that you are using. Here again you will need to find any
such instances and reassign an appropriate style to this text.

Whatever you do, be sure to save frequently (at least every half
hour) and also back up your work on a daily basis. That way if
something goes terribly wrong with your file and you can’t figure
out the problem, then at least you will only have lost a limited
amount of work.


